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o 4. BEBSTHENRIZFNIEFEH, FiEHM
_iﬁg B X REVEEF
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(FI5EM—HRER N

o PRATFI ]

- REARES, —EBEMS, LEHKHESEERLL.
s REIE

- BiEEARHE; EXHiEC;
o IRFE ]

= ﬁéﬂilﬂﬁiﬂiiﬁﬁﬂilﬁﬁﬁ?&lﬂfé\ My, ZEiE
ES_L_L FH*EE%_‘“: LEEXRIEE, BN, 'h:lFH TEFH“‘FI%)\
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o L#SERR
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IR ERSTER(EAL.
ek JFC ++FERNMW S o

- SRk, IBMR. Bk, ERBITENSENE—IER;
- ERFRK(DeBug)@itEHREREZMNRARZ—;
— ﬁ%i%ﬁﬁﬁ%iﬂ'ﬂﬂ! FEENEHRIZEER. debug.
P
X443 ZIPER! ZRRAL !
- RuABREMRREEING&IE, HLHERERF.
- BELXARBR. ZEIZINR, ERERZNER
##12. MSDN; CSDN;

- BFRFNIIEHEEER;
T B el FEmR

LEHlHBlE R IE RN
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o AN YA ELHEIEFE I RNIEFITIT
XA FER, EREFREITESFEERAZIEL
L*EE,JI*HT/\

e C++EXTUREEMEIENIER, AL

METE

EX REVFEF -

e C++IEREITEFS I EEINRIEFEITHY
g, C++HiESEEUREEEINS
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Preliminary Knowledge of C++ S

2o 2iHENER? BFBEH4H?
WAy 5 —{ C++FEFF?

1.1 MOCZIC++

1.2 HEBRICHIZFF

1.3 CHEFNARMBERI
1.4 CHIEFHIYRE FASCIY
1.5 <FC++ EHISERR
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*1.1 M\CEI|C++

MBS - CRES - BRES

FORTRAN (IBM) -1954, R%*¥itH
Ada (Ada Augusta Byron) -1983, #BEHERIT
Cobol (Common Busmess Orlented Language)

-1959, E‘EE’JI‘J%&%*IM: =pd

B RIS E G RS RES .

, A
BASIC 1964, ?"FORTRANl.:..:.E'JEﬁHLI:ﬁﬂ.’.n

EALTE

B8

AGHY,

C 1972, AxEDN/REIE ZEDennis.M.Ritchiefiff#l
AP EhﬁHM§LAm&ﬁm RKEBRGEHFNIF

ZNRARHESHREACRER.

http://blog.sina.com.cn/s/blog 4bddce2b(0102dw12.html

@D 201754726828= 1% CH++IHISHIR

Ysack|NexTS



Ada Augusta Byron P

o Zin-REHIE-FH(Ada
Augusta
Byron)1815£"'_:F£E

E R HHERKE
=A2FRATA-FR, 8%
EHFERZH- 1'5'*7)'_'?"'
( “the Princess of
Parallelograms”,
ITEBRAE),

o WXIIRITEHEARZR
E/r.B 05 (Charles
Bal_:age)E'J%la\ Fi5

BT T EIBMISIE. #HFR

rfg kb — i EHAR
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Dennis.M.Ritchie S

N

° %IE?+§$ILW‘%§£\CM)?§%H4J,
GRS ARLIRNE(1974); B
’—ﬁuEE—‘FIEUﬂijﬂrﬁ-* IEEE)
Emmanuel Piore ;zg982£
(B EH IS (ACMBER
(1983); F=.

e 19784 Brian W.Kernighian
%ﬂDennis\M.Rit__c_:hieth)%T%
&= (CEFRITES (The C
Programming -

Lan ) Y, _RCIES T EE

BB 2 —.
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XEHENER. REMEERBCH+TH “undefined iR
#Bikt “F&KStroustrupfi&F—# “ M

SMAFHTENMFEET,
EFEE'J‘I‘IA&Mk+1+§M¥$I

SN éﬁéilﬁlzmmﬁﬁm‘ﬂ*
. ; .: g :. INTT o
| SN e 19934, HTFECH+SUE
‘ST ij:mﬁ, Bj arne%’%ﬁ?
ACMizEE R Grace

Murray Hopperké@#ﬁﬁ.ﬁ
ACMPiET ( Association

Il;lor (i:‘omputer

acniner ]
PN v

: ﬁACMI‘%‘::tzEE/I\AIﬂ?.?ﬁE'J E
Bjarne Stroustrup, C++ * 19955, BYTE#:KM Hfﬂlﬁ
BN ENTIE, AR wiaaol phs o
ij “C++Zl\” o
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*1.2 REBAHC++IEF N

fil1.1 W —1TFFF-
#include <iostream> // 8E& 33 Htiostream

using namespace std; //{EHMATEstd
int main( )

{

cout<<"This is a C++ program.’;
return O;
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1.2 RKaFfnb@FE AN EZ .

B8

[/ REE¥ (XITRERET)
#include <iostream> / /TS
using namespace std; / / s & =g std
int main( ) [/ ERHET
{ //E_flﬁlﬁ-‘? =]
int a,b,sum; [/ ENTE
cin>>a>>b; //ﬁl)\l’&ﬂ
sum=a+b; / /R{EIEA)
/ /SiER]
cout<<"a+b="<<sum<<endl;
return O; / /1 BRE—1FE
bs [ [ RBEER
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$i1.3 B[N ExHyY, KEHEH

#include <iostream>

xE, T

[ [ AR an <

using namespace std; / /A= Estd

int main() /[ ERE

{ / /[ R &G
int max(int x,int y); //ﬂmax@%&{’ﬁp AA
int a,b,m; A
cin>>a>>b; //ﬁﬁj)\'*ia%ubﬁ'q{'ﬁ
m=max(a,b); / /AR maxeR
cout<<"max="
<<m<<'\n"; / /B K mAYE
return O; / /EFIEEIREEE

s [/ ERBER
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int z;
iIf(x>y) z=x;
else z=vy;
return(z);

@ 201744826 HE8=

int max(int x,inty) //ZEXmax&#,
//max&ﬁ{zls}
//ZERHH, EX !

B8

meheEd

Sz R

// !lﬂ%X>v , MY ER A2z
//EBM, Fyr{ERKLSZ

/ / Bz {EIR[E

F1E C++p9¥1L5HH
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1.3 C++EFNHRMNBERR <

e (1) BFE

FXHRERA.cpprIXXAITH-

o (2) REFBEEBFBLITILIERD:
AR/ /R *ERIRIE.

- OERS

857 o

- @FRALEE

- @ FFEREE
HOE X

TEX o
- DEY,

EARRIZARLER 5T o
HF(mained ).

A
Y g

89y (FERHSM AR ST ) . BFEXTA S
RRB R FAFERFPETARRNEER

ERIFERNERS, REFPLMAFHIAN
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B8

e (3) — 1N EHHHEAMIPSTLAR:
- QO REERR, NEBAE—1T. BIERHR. RKHHYAE
B, REREM. RBSH(FS)a. SHAE,
int max(int x,int y)
- @ RHYE, RYEET TENXIFESARNTS .
ok Bk — A BLFE:
o B EMARRY (ERBARAEARRS). BIEXTAEH+FrH
FroAE, RBAVFAFMEERRE N
o ITHERST. BT MHITIBERAMK, RRHEITHXRARIE, KA
SEIRER BRI Th &E -
o (4) BUAFEHK. —RREREY, 5%
ERITIER. BRI SSIRIENERRS
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e (5) C++REFEENAMaAINREHAIBRNIT.
e (6) C++EFBENRNBEH, FMEAUSS
ﬁzngﬁ**j‘lu\o

- AXIESH{IRFEFNEIGER, —1BENIERF
RRZHA—x{} .

e (7) FREFUHMMEASERNFRE, LUEMERF
AYAT I
- B “//MEEBN, SYEERE—T
- B xR AR EI#J%

° Eé:,]) C++EFFHNRF (FRRF) BRXNMEH
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WMIENIRZIEFF XA

o 1. HRIAMIN:

B8

- B RX AR K F VCHYRR B X8, EI]’E

¥/ 81
e 2. KIESHILE

BRI AR/ 85 ; SHITNER AL

- BHABHAESHE—ITHRG, MRERX

AESME—ITHE—L,

- KIESIUTT—1T, E3KH
_yu 9 19“;“] :
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e int main()
e {
o long II; /| BHEE
0 long ISum; / / BJEigsZHn
o float fAvg; / /[ BFEKIEE
. f;;-.("|1=0;|1< 10;1I++) [ /X BUHITR N
. {
o ISum=ISum+II;
. be
2 fAvg=ISum/10.0; / /K¥E)E
e }
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RN Z RS S

1, XHFRE:

MR FEFSLMAN LT TR
[1771111777777111777777771777777777177

// WH: XHFRERIER.

[/ E&: **, f2pd\: **

/ /[ #ad R EA R ThEE

// EERE: ............

// WA REACHFRUMR A, STREHAER.

[/ &G WA HRIEAE .. [RELLRZ BE.

[/ BEXE: ......
[111111177777777117777777771777777777/

o MHERTLUCHEIREIEE, tB2ATIH T EF
A AT LA ARIO(N_N)O~
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- s”  “EEE" . ‘TES

PY S q:.~ N (13 VN , “‘é L) (13 E b \ (13 =5

B, SHEAS 2 v Elﬁﬁﬂ” AN E AT AR TR
//===============================//

// TheE: M—4String FBr5—~ String

/] £#:. strByDelete,strToDelete

// 1BEl: FRBFIHMERIREL, BNIREO..... SHE RS
[/ EERR: AEEFEXRRARMEEBIEEK......

[/ BRAFGZE: ...
// BHA: 2000/8/21.9:40--2000/8/23.21:45
[/ ===============================//
o RFA(......) /] ThEE......
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WENRZEFRAE '

¢ 2, TERITHR:

. o FEERFRERE

BMER . [N 3T

= XE"EI%HEEE,JXE, .

AR Hlan:
e long II;
e long ISumy;
e float fAvg;

e long ILineCount / /%

@D 201754726828=

FE TR

T RNREIRAE

TS EHIR

MiZERE, {8 5("

LiFRIFTETUR

[/ RHEE

/[ SF0
[/ 7

21948
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RIERNBZERASE

e 4, E ﬂfrliﬁ
o EEIIGERRNEB—EES

857 Z R IRRGERE o

o HIEM. Fi. EFEFNERARERIZMLUERE
o XTHIBIRFAEBEER, EERPENFS

o f5lZn:
o //1. ... T
o for (...... )
.
o if(...... ) [/ ennnnn R
o {irenns e
o else [/ eenens TR
o T ¥
. 3
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1.4 C++EFNEEMIH 7%

—PMEFMNARBRBEEITHLER:
1. AC++REiRIEFF

C++RIEIRF (source program) 2ll.c
(c plus pl£us)1’ﬁjm!=fﬁﬂgﬁcz§ﬁc1¢ EACPP
2. MEEFHEITRIE

W URREF XA BEMARIFEN.
?JTE T EIERNITEIIESIEIE
Bz }comSu.erTi;,% S SRR
?Eﬁ*zr" FERL ] %UJL:‘:Y‘.E’J H ¥r#E2F (object

program).

-Ta}
A
=
?—l*
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B8

trizF—iRLl.objEk.ofE N /5% (object RI4E
5 mIFEFXIRIZF] ﬂrﬂzz*iil‘\”‘ﬁﬂl_}n;."'i’l‘\""E
gﬁﬁ%?ﬁin ziTuﬁﬁﬁmgﬁﬁt.ﬁﬁ1ﬁ G ﬁﬁ
WMIERGARTOEEESE D A, —%FFE-’EEBE
(error); —MEE&H (warning) .

3. FBEHEXHEE

R & inker) i — 1M EFRITB 51‘1?3{14:%!1
’%@EEI’J GANYSER Y mﬁ*ﬂ’]ﬂﬂﬁﬁ.’ BEiERERk,

R BAIPATHI ZEHIXHF (*.exe ) .
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B8

4. BITEF

BITREATXBBATITHI Z#HFIH(.exe
), BSAEITER.

5. hBITER

NRBITERAIERH, NMEERERFIFEER
EBI0E.
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Gkt |
N T
g |\

~

- B e~ [EhF
f.obj
JC /

/

Y
AT \

FARFE *_ M ELA H
f.exe o AT

A IETH

=
iy
_H

H‘HJFQE
%
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1.5 :FC++_FHE S

e ETMTCH+HIEFHNIMAG, RRETEN L%iF
FIBITC++I2FF, LUMRITC+ +RRERINR, HSE
EC++ 1Y _EHNER1E.

o A EARFINCH+EE RS, ERENFE TSN
T ANC+ 2R, R batr R 2R3

BIT— B

ViR, HEH TRABNC++EmIFRZG IS FN{ER
%5 EE% iﬂq‘ﬁ'é)l%% E,Egifir#'ﬁ #tw A ERES
e EEMHEER (C++EFEITIBRS LIES) —FB
hig B NZ T EVisual C++ 6.0F1GCCRAFELRE!FHIR
t%._Fﬁ?i'C++*E=E1¢Hg7’iifo
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« BEH.

o CHIC++HIPEHRE
o FIC++IEFRITHIER

* TR ]A

e P16: 7. 9. 10

o —E:
o fTARE

/

N HEALRY

1) 2

o WAV EAI P2 AT F Y ?
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Visual C+ + &G #ER o
1. BEi5R A

_ =] ]
Filz Edit ¥iew Insert Project Build Tools Window Help
| =t 282 - [EER | S[synr =l
4|

TEH BERIDRIEE O

lalx

mEECEwE. Hil)

*["Build 4 Debus » Find in Files 1 » Find in Files 4/ 4] |

Ready

D 2017547268280= F1E C++H415MRA a1 L=



2. ITeEO

<
ol

E--- ViewMode classes
- ™% BChieny

FIRAE:
View->Workspace

ClassView—3{i1 &

FileView— {41 E]

=R ERFESRRING E:"{_ EHenE LR
M =P R ERERIER : WEF IR,

. KL S Cfiewhdodeloc
Resourses—:&EE }Axﬁﬁ%‘% Ciiewhadeliew

E.'[: BCMenubata
- ™% BCMenubemDC
E'Tﬂ CaboutDlg
Eltj CautaFont

fo

N

o W8 el Modedpp

-1 CWEBUTion
(7] Globals

@D 201754726828=
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3. IR %mEEL

EHF'SﬁEEEF'
Ao T_ kiE "THE
EEIFFEI?I" IRERT ,

SHIaE.

@ 201744826 A=

AR

B8

# include {iostream?
using namespace std;

int main{)

{
int max({int x,int y);
int a,b,c;

cin}>a>>b;

c=max(a,bh);
cout<{<{"max=""<<{c{{endl;

return 8;

H

int max{int x,int y)

I

&
LN ES
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4, HEED S5

&

B LIR - WMEEO |, ARSI
mFRIRER SHSHE - Alt+2

Wérrfi';:gr‘) 3EA : view>Output
RIS

| XHBHERSE

201744526 HE#H= F1IE C++HHLHIR 44 @@



5. VC+ +3EH

B8

Hgm it Yiew I_[_nnr@

IEEE!/

ZREATI

@ 201744826 A=

HRIF , 1B
1TIEFE
=]

F1E C++p9¥1L5HH
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6. EEF LI

(1) #hiEtER (File>New)

(2) SAEkIREIERF

( 3) IRF ER (File>Save — Ctrl+5s)
(4) $RiFERFE ( Compile - Ctrl+F7)

(5)#

23 /12 ( Build - F7)

(6) 1&17fE% ( Execute — Ctrl+F5)
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(1) FEieF—$—% %
B% . EWindowsHFEERSHNFET FEIPMABR.
mfa , BifFile>New , £ “FEIRB" XiREARRAIR

B

2] x|
Files Projects | YWorkspaces | Other Documents I
~IWin32 Console Applicdl{iun Project name:
@Winiﬂ Dynamic-Link Library IFirst Test
%] Win32 Static Library
Location:
|F:'-.FENGWEI'||,First Test J
& Create new workspace
 Add to current workspace
[T Dependency of:
Platforms:
V\Win32
4] [+

0K Cancel
@ 201754F 20 HEM= F1m CFFEIRISATE &7 @@



(1) FEiEF—SB=F
BES , BT "OKIEHIE |

l% hat kind of Console Application do you
want to create?

* An empty project.

" A simple application.

" A"Hello, World!"' application.

" An application that supports MFC.

2 x

B8

< Back | Next > | FEinish Cancel

@D 201754726828= 1% CH++IHISHIR



(1) FEiEF—S=F

¥ LS, T “Finish”igfH , I§ T "OK”ix

Mew Project Information

YWin32 Console Application will create a new skeleton project with the following
specifications:

+ Empty console application.
+ No files will be created or added to the project.

Project Directory:
FAFENGWENRFirst Test

(1] 4 Cancel

X
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(1) FiEieFE—$ns B 1 &

BEFile>New , £ “"FiEXH" YHEEPRREA G
73.cppBIEE |

vew 2 x|

Files | Projects | YWorkspaces | Other Documents I

2| Binary File .
#5|Bitmap File First Test Ll
[] C}C++ Header File

[ C++ Source File

& Cursor File File

[eel Fortran Fixed Format Source File -
Fortran Free Format Source File IFIrSt Lkt Lagramsesths,
[8]HTML Page _

| Jlcon File % Location:

EMacru File IF:'-,FENGWEI'-,First Test __l
o

Al:tive Server Page ¥ Add to project:

Hesource Script
= Hesource Template
SQL Script File
Text File

0K Cancel
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(1) FEiEF— St S
B , EWindowsFH FSERENFEFT FTEINMNARFH
FLARFEFEFR. Mg, BEFile>New , £ "FHiENH"
YHEERNREE . cpplIiHS |

Files | Projects | YWorkspaces | Othﬂﬁjucumﬂnts I

+#|Active Server Page [T Add to project:

Binary File

| Bitmap File | -"'_I

[] C}C++ Header File
[ C++ Source File

& Cursor File File

[eel Fortran Fixed Format Source File -

Fortran Free Format Source File !F"St C++ Program Test.CPP
[#]HTML Page )

| _Jlcon File Location:

4= Macro File |FAFENGWEI _|

s Hesource Script
) Resource Template

SQL Script File
Text File

0K Cancel
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(2) RigER
FZEE , T "OKEHHIE | A, RIBIER

Bi First C+-+ Program Test.CPP

B8

=10/ x|

# include <{iostream>
using namespace std;

int maing{)

{
int max{int x,int y);
int a,b,c;

cin>>a>>b:]
c=max{a,b);
cout<{{"max=""<{c<<endl;

return 0;
s
int max({int =,int y)
1
<1

=
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(3) RFER
ZLE , REFER
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(4. 5. 6) ¥, B, 1B7ER
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: Compile (Ctrl+F7) , T

AR “Output”’BEO:

x| |
JjFirst_c_program_test.obj - 0 error(s). 0 warning(s) .
1l 4i“i‘\ Build £ Debusz » Find in Files 1 » Find in Files ] ‘115 _P‘l_‘
. + 7

° 29 °

: Build (F7) , FE$gAIAY “Output”&EO:
Z -
|[Fisrt Test.exe - 0 error(s), 0 warningis) ‘
~ |

*i*ix l?_n}_l_l_l_l;l,{__];lebug_ }\ Find in Files 1 » Find in Files EI_Ii L&

: Execute ( Ctrl+F5) ,

MITEER:

Press any key to continue_
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New

Files Projects l Workspaces ] Other Documents ]

2] ATL COM App'Wizard

%] Cluster Resource Type Wizard
7 Custom AppWizard
ieDatabase Project

2 DevStudio Add-in Wizard

2 Extended Stored Proc Wizard
gn |5AP] Extension Wizard

=] Makefile

fi= MFC ActiveX ControlWizard

[ MFC AppWizard [dIl] ’
7+ MFC AppWizard [exe]

X New Database Wizard

11 Utility Project

=]|Win32 Application

—Win32 Console Application
%]Win32 Dynamic-Link Library
%] Win32 Static Library

Project name:

JAppWizard @i E—1MFCR R H 3%

2 /X

Ihelln

Location:

IE:\CH\heIIu

&« Create new workspace

"l

A:l

Platforms:

V¥in32

HOI-\=

0K

Cancel
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2. HENRAWMEMNEKRBHIZFIES (AT

Application

File Edit Yiew Window Help Bl /hat type of application would you like to create?

LI TICT]

-l

Docament 1 ﬁl (" single document

+ iMultiple documents

(" Dialog based

¥ Document/¥iew architecture support?

What language would you like your resources in?

|tz [ [E)] (APPWZCHS.DLL) ~]

< Back Next > Einish Cancel l
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3. RENSEETESR (ASSE2) ©

-

" Header files only

" Database view without file support

" Database view with file support

If you include a database view, you must select a
data source.

Mo data source is selected.

< Back Next >
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4.1 2FEEVNHEX:

MFC AppWizard - Step 3 of 6

Application

File Edit ¥Yiew Window Help

include?

LLIICTTICT]

& [ane &~

Container

Full-server

~
(" Mini-server
~
~

[H.-'-‘
= Mo

| Automation
v ActiveX Controls

FAN (RISFFE3)

What compound document support would you like to

Both container and server

What other support would you like to include?

B8
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< Back Next >

Finish

Cancel
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5. EEEOSERTAZNRRE (HSEEAY

YWhat features would you like to include?
[f LY Edit Wiew Window Help

LL]

¥ Docking toolbar

Primt...
Print Preview
Print Setup...

v Initial status bar

Exit ¥ Printing and print preview
[~ Context-sensitive Help

W 3D controls

[ MAPI] [Messaging API)

I Windows Sockets

How do you want your toolbars to look?

Editing Control: IFletord

F Check Box @ Radioc Button
D Radic Button

* Mormal

" Internet Explorer HeBars

How many files would you like on your recent file

list?
4 —t Advanced... ‘
< Back Next > Finish | Cancel

|
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6. HEMBMNESF (RFPE]RS)

MFC AppWizard - Step 5 of 6

I

Project

A TODO:

% Microsoit Developer Studio
File Edit ¥iew Insert Build Help

[B] I"roitct.cEE

o

A TODO:

Beady

+ MFC Standard

" Windows Explorer

+* Yes, please

" No, thank you

* As a shared DLL

What style of project would you like ?

YWould you like to generate source file comments?

How would vou like to use the MFC library?

" As a statically linked library

B8

< Back

Next >

Finish

Cancel
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7_ s New Project Information

HOME]

AppWizard will create a new skeleton project with the following specifications:

I Application type of hello:
Multiple Document Interface Application targeting:
Win32

Classes to be created:
Application: CHelloApp in hello.h and hello.cpp
Frame: CMainFrame in MainFrm.h and MainFrm.cpp
MDIChildFrame: CChildFrame in ChildFrm.h and ChildFrm.cpp
Document: CHelloDoc in helloDoc.h and helloDoc.cpp
VYiew:. CHello¥iew in helloYiew.h and helloYiew.cpp

Features:
+ Initial toolbar in main frame
+ Initial status bar in main frame
+ Printing and Print Preview support in view
+ 3D Controls
+ Uses shared DLL implementation [MFCA42.DLL]
+ ActiveX Controls support enabled
+ Localizable text in:

T E]

Project Directory:
EAC++hello ’

l : 0K Cancel |
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8. T H Hy 4R R

* hello - Microsoft Visual C++ - [MainFrm_h]

. §D Eile Edit View Insert Project Build Tools Window Help =
g_: 2 sHG | e o E ﬁa.hmat 1|
-]CMalnFrame _]1[AII class memhers__ﬂ _jﬂ sy o 1 ELMm _
-l [/ MainFrm.h : interface of the CMainFrame class =
= hello classes Vi —
+-*® CAboutDlg
= ®= CChildFrame W T
=-®15 CHelloApp
: ::j g:z::z&z& #it ldefined(AFX_MAINFRM_H_ 6F98119D_ECBO0_41 3F_BQTC_C5C085523890_|NCLUE_
= #define AFX_MAINFRM_H_ 6F98119D_ECB0_413F_B97C_C5C0B5523890__ INCLUDED
-] Globals
#it _MSC_VER = 1000
#pragma once
#endit // _MSC_VER = 1000
class CMainFrame : public CMDIFrameWnd
{
DECLARE_DYNAMIC(CMainFrame)
public:
CMainFrame();
J__':-SCI... _glﬂe...__?a Fil..| || 4/] L‘_l
= a|
A
| 1 1\ BulldK Debug % Find in Files 1 % Find in Files 2 }\R| 4] i b r

@201324}%26523}15 F1E C++HTSHIR @@



8. T H Hy 4R R

"+ hello - Microsoft Visual C++ - [helloView.cpp *]

B File Edit View Insert Project Build Tools Window Help = | =] -
|8 @@ s 2@ 2 DER G 1| ] ’
) .]CHellu\l'iew _:]][AII class memhers_ﬂ] & OnDraw j-_ﬂ > @ B E M |
= s W O j
=-E#l hello classes - .
™ CAboutDlg Il CHelloView drawing
+-*5 CChildFrame
i 15 CHelloApp void CHelloView::OnDraw(CDC* pDC)
+-* CHelloDoc
=" CHelloView {
. ¢ AssentValid() CHelloDoc* pDoc = GetDocument();
% CHelloView() :
& "CHelloView] ASSERT_VALID(pDoc); .
- ¢ Dump(CDumg // TODO: add draw code for native data here
: @0 GetDocument Il TRACE("This was printed during debugging\n™);
:% pDC->TextOut(20,20," Wil AR ZKEE | "):
% OnEndPrintin }
. % OnPreparePri
+ -[5 cL':Eﬁﬁ:jf;Ew" s e
&[] Globals I/ CHelloView printing
3 BOOL CHelloView::OnPreparePrinting(CPrintinfo™ pinfo)
r b. 4
ATETE ﬂJ

|| [<{[»]"Build { Debug 3 Find in Files 1 § Find in Files 2 3 K4/ | v
Ready [ Ln 60, Col 48 [REC|COL [O¥R [READ
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“ hello - Hellol
§| =P #WE\E =EEBN) =BEOMW) FEEIH)

=EX

._ wH i EBER &S| P
B Hellol
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]

EeF | 4
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